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OVERVIEW 

Digital preservation and access  

The digitization of an image is a way to preserve risk or delicate photographic material.  A high 
quality scan that represents the original in as true a state as possible is the goal of archival 
preservation and the creation of a “Digital Master” image.   A second copy of this “Digital 
Master” is often made to enhance the appearance of the image by adjusting the colour, 
removing scratches or cropping the image to suit your purpose.  Since this corrected version 
will still be a large file, secondary, access copies are usually made for viewing and sharing.  This 
manual describes these processes.   The manual is based on best practices and archival 
standards, but can be adjusted to suit your needs.   

Digital Masters – Uncorrected Scan 
This manual provide technical benchmarks for the creation of “digital master” raster image 
(pixel-based) files. The primary objective is to produce digital images that look like the original 
media (photograph, negative, slide, etc.) and are a “reasonable reproduction” without 
enhancement. Digital masters are files used for the creation of additional derivative files for 
access, distribution and/or display via a monitor and for reproduction purposes via hardcopy 
output at a range of sizes using a variety of printing devices.  

Digital master image files capture the image at the time of scanning, not what it may once have 
looked like if restored to its original condition.  

Digital Masters – Corrected versions 
Generally for access, a corrected version of the master image is created.  Adjustment to the 
colour balance or removing scratches and other damage, and crops the image for use is applied 
to a secondary “master”.  This manual includes information on how to use PhotoShop to create 
corrected images.  

Access Version – Lower resolution copies 
For many purposes a lower resolution copy of the corrected version of the image will be most 
useful for a user.  This manual describes how to create access copies for printing or web 
viewing.  A second on IrfanView (a freeware program) describes how you can convert images 
from high resolution “TIFF” files to more user-friendly “JPEG” files, and how to use this program 
to change the resolution of the images to make them smaller for sharing.  
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Media Covered In This Manual 

This manual was developed to use with an Epson Expression 10000XL flatbed scanner, and it 
can easily be adjusted to use with other Epson flatbed scanners. Since the scanning software for 
your scanner may be different, you may want to replace the screen shots or supplement the 
manual to work with your specific make and model.    

 

Formats Covered in this Manual 

35 mm film negative strips  

35 mm slides 

Medium format film (120/220, 2¼, or Brownie) 6 x 4, 6 x 6, 6 x 7, 6 x 9.  

4 x 5 inch film 

6 x 6 cm slides 

Odd-sized Film or Slides 

Photographic Prints 

Documents  
(architectural drawing, collection ledgers) 

Stitched images or documents 

 

Digital Image Formats 

There are two main types of digital image files 1) raster images, made up of a grid of dots called 
pixels and 2) vector files which are made up of geometric shapes.  Vector files are commonly 
used for design work such as logos and printing of brochures, etc.  They scale without losing 
quality.  Unfortunately, vector images cannot depict the subtle shading of a photograph.   

This manual discusses the digital capture of raster files in the TIFF format and the creation of 
JPEG files from them.  

TIFF (Tagged Image File Format) is the usual format for preservation master files.  It is a widely 
accepted, open standard.   These files can be very large so are not suitable for web delivery or 
sharing generally.   

JPEG (Joint Photographic Experts Group) are files using a compression algorithm (calculation) to 
decrease the file size of an image, such as a TIFF to allow online access and quicker downloads.  
Changes to bit depth and resolution can greatly affect the quality and scalability of JPEG.  

To learn more about image formats see Section C1. Digitization resources (Images) page in the 
Indigitization Toolkit:  

http://www.indigitization.ca/indigitization-toolkit/digitization-best-practices-and-guides/digitization-resources/ 

http://www.indigitization.ca/indigitization-toolkit/digitization-best-practices-and-guides/digitization-resources/
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Before Getting Started  

Folder structure and file naming planning  
 
Determine where you will store your images  

 Will you store them on the local computer temporarily because the scans will be faster?  

 Will you move the files to a networked drive, or a portable storage drive; will you create 
a second copy of the masters?  

 Or, will you scan directly to networked location?  

Decide the folder structure for the images  

 Will you create a project hierarchy or use an arbitrary numbering system?   

 Avoid deep folder hierarchies  

 Be consistent (don’t use special characters in the folder names)  

Determine before you start your project your file naming strategy.  

 Consider using the scanning software’s ability to auto generate numbers.  Using this 
sequencing ability of auto generated numbers can help prevent duplicate numbers and 
can speed up processing  (e.g. the Epson scanner allows you to create a prefix and a 
three digit number that is auto generated as in):  

Prefix: abc02  Start Number: 001 for a filename abc02001.tif 
or Prefix: 2016-06-12_ Start number: 001 for a filename 2016-06-12_001.tif  

 Follow file-naming best practices (below)  

File-naming conventions and best practices  
 

 Keep file names short, but use adequate identifying information  

 Use characters (a-z) and (0-9) and avoid upper-case  

 Do not use spaces or special characters (such as / . , “ ‘ ? ! % * ^ @ [ ] etc.) 

 Use underscores or hyphens to separate elements in the file name and help to make 
them more readable 

 If using dates use YYYYMMDD or YYYY-MM-DD  

 Use the period (.) only before the file extension as in .tif or .jpg and always make sure 
the file extension is included in the filename  

Other file naming considerations  

 Use filenames that correspond to the original media, if practical for the prefix 
(converting spaces to underscores, developing project codes to shorten and avoiding 
special characters0 and then use the automated numbers for sequences, where 
possible.  

 For corrected and access versions, maintain the original filename for the master and add 
codes for the type.  For example for a corrected master you could add a “c” as in  
2016-06-12_001c.tif  
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Scanner software automated numbering  
 

Most scanning software will automatically number your files in increments of one. It will also 
allow you to put a set prefix.  If you select an alpha-numeric sequence with a letter and three 
numbers, you will need to pay attention and change the set prefix every thousand images (i.e. 
at image a001000, a002000, etc.)  You may also need to pay attention every new time you open 
up the software – it remembers the prefixes and destination drive from the last time it was 
used, so if someone else has used the scanner in the interim, you will need to re-set this 
information to carry on from the file name where you last left off.  

Important: the Epson’s increments are from 001-999.   It will not jump to the next thousandth 
and continue, ie. 999 -> 1000 -> 1001. You will have to scan separately and hand name any file 
number ending in 000. Then start the next thousandth series batch at 001.  

Making a contact sheet (from negative strips)  
 
When working with negatives, you may want to make contact sheets so you can track the 
numbers you have assigned to the negatives.  
 

1. For an Epson flatbed scanner 
2. Remove the padded insert from the inside top cover of the scanner 

3. Place the “film area guide” onto the scanner bed, matching up the white triangle with 
the top right corner of the scanner bed.  

4. Check that the negatives are all the correct orientation in the archival negative sleeves 
5. Place the negative sheet (still in archival negative sleeves) face down on the scanner 

bed, centered within the film area guide as much as possible. For sheets with a lot of 
negatives– this is OK, as long as each negative can be fit into the film area guide. For 
archival negative sleeves with 6 rows of strips of 6 negatives, scan the sheet in two 
separate scans, scanning the first 4 rows of negatives on one scan, and the second 2 
rows (plus extra sheet) scanned on a second scan.  

6. Open EpsonScan from the Programs menu on the computer. An EPSON Scan window 
will appear. Change settings, then scan and save as indicated in the diagram on the 
following pages.  

7. Save contact sheet to the appropriate folder and consider including the range of file 
numbers assigned to these images in the contact sheets as part of the file name.  

8. Print out a copy of the contact sheet for next steps 
9. File with negatives after scanning and numbering.  
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For 35 mm negatives or 6 x 6 negatives  
 

1. Make a scanned contact sheet.  
2. Print out scanned contact sheet.  
3. Scan negatives & save to appropriate folder  
4. Write file names on contact sheet printout.  Put contact sheet printout in binder, or file 

folder.  
5. Label the negative sheet with file name range  
6. Apply appropriate metadata template to uncorrected (preservation copy) files in Adobe 

Bridge (or PhotoShop) (see below).  
7. Open files in Photoshop. Perform necessary orientation, cropping, and attach colour 

profile. 
8. Save (preservation copy) file to the folder where the master images are stored.  
9. Perform any additional corrections to file; levels and curves adjustments as needed as 

per (Part 4: Post-Scanning, Image Adjustment and Correction) then Save As  file to 
appropriate corrected folder with file name+c (if using “c” to indicate “corrected”).  

10. Consider using a spreadsheet to record the image description.  Name the spreadsheet to 
reflect the project or collection you are working on and the date you begin (YYYYMMDD 
format).   

For 35 mm slides  
 

1. Follow directions for slide scanning  
2. Batch scan 
3. Write file names on the slides in pencil 
4. Label the  negative sheet with file name range  
5. Follow steps 6- 10 as above  

Digitizing other image formats  
 

1. Review the table of contents for Part 2 of this manual to determine best method for 
scanning the format at hand.  

2. Consider following the methodology above to document file names on paper records in 
the binders, spreadsheets, etc.  

3. Number and save images in accordance with your file naming standard.  
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METADATA: CREATING AND APPLYING METADATA TO  
THE DIGITAL MASTER IMAGE 

General Rules for Adding Text to Metadata Templates 

Avoid using grammatical markings that may be translated by different programs. For example, 
avoid backslash ( / ) , colons ( : ) , and semicolons ( ; ) as they may cause problems if merged 
into another database. Replace them with spaces or safe markings, such as a dash.  In file 
naming, insure that file extensions are included with a preceding period (.).  Avoid periods in 
other positions in the file name.  

In addition to the unchangeable embedded technical metadata, it is possible to append 
additional metadata that is embedded in the image file. This additional metadata is editable. 
Using Adobe Bridge, it is possible to create individualized templates and apply them to batches 
of images. 

Create a Metadata Template 

1. Open Adobe Bridge  
 

2. Navigate to the folder that contains the images to which you want to append 
metadata (see Directory section following). Previews of the images/files will appear in 
the “Content” column. If you select one particular image, a larger thumbnail and its 
metadata will appear on the right. 
 

3. Open the Create Metadata Template dialog box from the menu bar.  
Choose Tools -> Create Metadata Template... 
The Create Metadata Template dialog box will appear. 

4. Enter the appropriate metadata to the fields into the IPTC Core section. 

 

Note: You can apply a metadata template to individual images in Photoshop under 
File -> File Info  

  



Part 1: Introduction to digital imaging                                                                                       8 
 

 

 

Creator: Name of Photographer (if known – in natural order, 
otherwise leave blank)  

Creator : Job Title Photographer (leave blank if no name in “Creator”) 

Source: Your organization’s name  

Copyright Notice: Copyright held by Owner of material or Photographers 
Name(leave blank if not known)if his/her copyright still 
applies 

Copyright Status Where copyright is indicated above select 
“Copyrighted” from the drop down list or leave default 
“Unknown”. This should be determined in advance for 
collections, fonds, or individual images as required.  

Rights Usage Terms: (contents dependent on project; leave blank if 
unknown or undecided at point of scanning)  

 

5. Give the Template a name, using your name to personalize. For example, the file 
naming for each template could start with your initials followed by an underscore, 
followed by the short form of the collection name followed by the box and location of 
the original media.   

So for a MOA Archival example: “AS_Gill_Multi_box3” the components are Ann 
Stevenson’s initials, Gill for Kuldip Gill fonds and Multi_box3 for the storage box Multiple 
Private Records Box 3.    
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6. Click the Save button to save the Template.  Check to make sure the template is saving 
to the Templates folder.   
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Apply Metadata to Digital Master Image 

Apply metadata to the Digital Master image.  

Later, when you use the Digital Master to create any corrected versions, all derivative copies 
will inherit the metadata intact. This way the Digital Master and subsequent access images, or 
any derivatives, will have consistent metadata. 

Completing a spreadsheet for each project or collection digitized 

In order to keep track of digitizing an “item-level” spreadsheet can be completed for each 
project or collection.  The following outlines how to complete the spreadsheet.  

Note:  If the data in each spreadsheet might be imported into another management system or 
database, consider using the old Excel format (Excel 97-2003 Workbook) and make sure all the 
data cells are set as “text” or make sure that the data type for any set of cells will transfer 
properly to the other system.  Date and number fields can be challenging to make compatible.  



                                                                      

TECHNICAL OVERVIEW 

The Epson Scanner 

Epson Expression 10000XL: 
Scans  35-mm filmstrips, 35-mm slides, medium format film, 4x5 inch film, odd-sized 
film and slides, photographic prints, two-dimensional artwork, and documents. 
Load the film with the matt emulsion side up (shiny base side down). 

Epson Recommended Scanner Glass Wipes and Cleaners 

Clean dust and smudges from the document table glass with a soft, dry cloth (PEC*PAD 
is good), or microfiber glass cleaning cloth .   

You can also used compressed air spray to remove dust. Be sure to use as directed so 
that no canister residue lands on the scanner glass. 

To remove grease, use pre-treated E-WIPES lens or scanner wipes, or a small amount of 
glass cleaner on a soft cloth.  Dry the document table glass afterwards. 

Never spray glass cleaner directly on the document table. Always spray it on a cloth first, 
and then wipe the glass. 

Do not place the scanner on an unstable surface. 

 

Handling Film 

Always use cotton gloves when handling film or prints.  

Work in a clean, dust free environment. Do not leave negatives in direct sunlight. 

Clean dust off negatives using compressed air or a clean, dry lens brush.  
If dust persists, use a soft cloth for negatives (or a PEC*PADs wipe), or negative/film 
cleaning solution (PEC-12).  
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Colour Profile (also Colour Mode or Colour Space) 

Setting the color profile is critical to digital capture and can be set within the EPSON 
Scan software prior to digital scanning. 

A color profile simply describes the range of colors, or gamut, that a camera can see, a 
printer can print or a monitor can display. Color profiles, such as Adobe RGB, are device-
independent and determine a color range you can work in. Their design allows you to 
edit images in a controlled, consistent manner. Adobe RGB has a wide gamut space, 
which allows for greater color information to be captured about the original item and 
allows for conversion or downsizing to a narrow space later. 

Not all hardware and software combinations produce the same color and tonal 
conversion, and even this workflow will not always produce the same results across all 
output devices. Colour Profiles are used so that we can get as close to some proximity of 
a colour standard across monitors and printers. 

 

Recommended Color Profile for Colour Images 
Adobe RGB 1998 is recommended for colour images. 

Recommended Black-and-White Profile for Black-and-White Images 
Gray Gamma 2.2 is recommended for grayscale images. 

 

Avoid saving files in CMYK mode. I you need to supply a CMYK file to a publisher or 
printer, convert to CMYK or LAB profile from an Adobe RGB tiff. 

 

Setting the Color Profile  
See Scanner Instructions 
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Bit Depth or Colour Depth 

In computer graphics, bit depth is the number of bits used to represent the color of a 
single pixel in a bitmapped image. Higher the number of color bit depth produces a 
broader range of distinct colors available in the image file. 

 

Black-and White 
Grayscale image files consist of a single channel, commonly either 8-bits (256 levels) or 
16-bits (65,536 levels) per pixel with the tonal values ranging from black to white.   
16-bit depth is recommended for scanning black-and-white images. 

Colour 
Color images consist of three or more grayscale channels that represent color (R,G,B) 
and brightness information: 3 channels x 16-bits = 48-bit color.    
48-bit depth is recommended for scanning colour images. 

 

 

Scanning Black-And-White Images in Colour or Grayscale? 

16-bit Grayscale is usually sufficient to capture black-and-white tones from a black-and-
white image source that is preserved well or unstained.   

 

If the black-and-white film or print source is very old, has faded significantly or is 
stained, then it might be better to scan to colour and produce an RGB scan image.  
Black-and-white negatives or prints which have staining, discoloured film base, 
retouching, intensification, or other discolourations (both intentional and the result of 
deterioration) can be optimized by scanning in colour, then adjusting the colour image 
and finally performing an appropriate conversion to grayscale.  

 

Each colour channel will have to be evaluated individually to determine the adjustment 
needed in order to minimize the appearance of any deterioration and optimizes the 
monochrome image quality. The correction can then be used for the conversion to a 
grayscale image. 

 

See the section in Post-Scanning Image Adjustments and Corrections to get more 
information on correcting scanned images. 
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Resolution Guidelines 

DPI or PPI is the resolution, in pixels, of an image to be printed within a specified space. 
For instance, a 100 x 100 pixel image that is printed in a 1-inch square could be said to 
have 100 dots per inch (DPI) or 100 pixels per inch (PPI). Used in this way, the 
measurement is meaningful when printing an image. Good quality photographs usually 
require a minimum of 300 dots per inch when printed. 

Determining Resolution Size 
In order to produce an archival quality image file that will print at good quality up to 12 
inches at the longest side, use the following table to determine the scan dpi or ppi 
resolution size: 
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Resolution Table 

Original Format 

Original    Longest 

Side 

To Print 

Longest Side to 

12" at 300 dpi, 

To Print 

Longest Side to 

12" at 600 dpi 

Use Scanner Mode 

    Scan at dpi/ppi Scan at dpi/ppi Document Transparency 

Photograph 1" inch 3600 7200 Flat bed   

  2" inches 1800 3600 Flat bed   

  3" inches 1200 2400 Flat bed   

  4" inches 900 1800 Flat bed   

  5" inches 720 1440 Flat bed   

  6" inches 600 1200 Flat bed   

  7" inches 514 1028 Flat bed   

  8" inches 450 900 Flat bed   

  9" inches 400 800 Flat bed   

  10" inches 360 720 Flat bed   

  11" inches 327 654 Flat bed   

  12" inches 300 600 Flat bed   

FILM SIZES          

35mm slide 36 x 24 mm 2700 5400   Use Holder  

35mm film 36 x 24 mm 2700 5400   Use Holder  

120 Frames            

6 x 4.5 56 x 41.5 mm 2203 4406   Use Holder  

6 x 6 56 x 56 mm 1632 3264   Use Holder  

6 x 7  56 x 70 mm 1306 2612   Use Holder  

6 x 8  56 x 77 mm 1187 2374   Use Holder  

6 x 9 56 x 84 mm 1088 2176   Use Holder  

6 x 12 56 x 118 mm 775 1550   Use Holder  

6 x 17 56 x 168 mm 544 1088   Use Holder  

6 x 24 56 x 224 mm 408 816   Flat bed 

6 x 6 Slide 56 x 56 mm 1632 3264   Flat bed 

4" x 5" 4" x 5"  800 1600   Use Holder 

Larger, or Odd-

sized Negatives 

measure longest 

side 

Use size for 

Photograph  

Use size for 

Photograph  

  Flat bed 

Document measure longest 

side 

Use size for 

Photograph  

Use size for 

Photograph  

Flat bed   

 
 



 

Part 2 : 
Scanning with the 
Epson Expression 
10000XL Scanner 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
These guidelines provide technical instructions for the use of scanners and the standard creation of digital 
master image files. 
Prepared by Elizabeth Padilla, (23 Feb 2011) 
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Part 2: Scanning with the Epson Expression 10000XL Scanner 
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TECHNICAL OVERVIEW 

 

Inventory of Epson Expression 10000XL Scanner Equipment 

Equipment in the Digitization Workstation (June 2016) 

 

Equipment  

Epson Expression 10000XL 

USB cable 

Power cord 

Transparency top lid unit (with attached cable) 

Transparency guide 

Flatbed white background document top lid unit 

35mm slide holder  (2 quantity) 

35mm film strip holder (2 quantity) 

120/220 strip film holder (2 quantity) 

4 x 5 inch film holder (2 quantity) 
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BEFORE YOU BEGIN 

Clean the Scanner 

Use compressed air to remove dust from the glass document table. 

Gently clean smudges from the document table glass with a soft, clean, dry, lens cloth.  
A microfiber glass cleaning cloth is recommended.  

For more persistent marks, you may use a lens cleaning solvent.  
Never spray any cleaner directly onto the glass.  
Spray cleaner onto the cloth first, then wipe the glass. 

Turn the Scanner On 

Turn on the Epson the Scanner 

Press the  Power button to turn on the Epson Expression 10000XL scanner. 

 

 

Check the Calibration of the Scanner 

During digitization projects, tests should be performed on a routine basis to ensure 
scanners and digital cameras/copy systems are performing optimally. 
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Set the Colour Profile (also Colour Mode or Colour Space) 

Colour Profile 
Setting the color profile is critical to digital capture and can be set within the EPSON 
Scan software prior to digital scanning. 

A color profile simply describes the range of colors, or gamut, that a camera can see, a 
printer can print or a monitor can display. Color profiles, such as Adobe RGB, are device-
independent and determine a color range you can work in. Their design allows you to 
edit images in a controlled, consistent manner. Adobe RGB has a wide gamut space 
which allows for greater color information to be captured about the original item and 
allows for conversion or downsizing to a narrow space later. 

Not all hardware and software combinations produce the same color and tonal 
conversion, and even this workflow will not always produce the same results across all 
output devices. Colour Profiles are used so that we can get as close to some proximity of 
a colour standard across monitors and printers. 

Recommended Color Profiles 
Colour Images  
Adobe RGB 1998 is recommended for colour images. 

Black-and-White Images 
Gray Gamma 2.2 is recommended for grayscale images. 

Avoid saving files in CMYK mode. 
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Setting the Color Profile in EPSON Scan 
 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Colour Images Black-And-White Images 
Adobe (RGB) 1998 is the recommended color 
profile for colour images. 

Gray Gamma 2.2 is the recommended color 
profile for grayscale images. 

3. Choose the Color tab. 
4. Select the ColorSync radio button 

option 

3. Choose the Color tab. 
4. Select the Color Control radio button 

option 

Color Profiles can be set in the EPSON 
Scan software configuration settings 
before you start scanning. 

 

1. Open EPSON Scan software from 
the desktop Applications. An 
EPSON Scan window will appear.  
 

2. Click the Configuration button at 
the bottom of the EPSON Scan 
window. 

 

3. The Configuration dialog box will 
open. 
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5. For Source (Scanner):  
select EPSON Standard 

6. For Target:  
select Adobe RGB 

7. Auto Exposure Level 
should be Low 

8. Click OK to set this configuration. 
 

5. Uncheck the,  
Continuous auto exposure box 

6. For Display Gamma:  
select 2.2 

7. Auto Exposure Level 
should be Low. 

8. Click OK to set this configuration. 
 

 

Note for B&W images: 
EPSON Scan does not let you specifically assign Gray Gamma 2.2, so the color profile 
must be assigned in Photoshop during the Post–Scan adjustment. 
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SCANNING FILM, SLIDES, AND TRANSPARENT MEDIUM 

Use the Transparency Mode 

1. Remove the white reflective document mat, by sliding it upward. 
2. And freeing the bottom edge, then lowering and slide it out completely.  
3. Place the mat in the storage slot on top of the scanner lid. 

 

 

4. Insert the transparency 
guide onto the back edge of 
the document glass so that 
the alignment pins of the 
guide fit into the holes on 
the scanner. 
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Use the Appropriate Film Holder for the Film Media 

 

Use the appropriate film holders to scan 35 mm slides, 35 mm film strips, 4 x 5 inch film, 
and medium format (120/220) 6x6, 6x9, 6x12 film. 

 

Load the Film, Slides, and Transparent Media with the Matt 
Emulsion Side Up (shiny base side down) 

When film is examined under bright light, the image on the emulsion surface will be in 
slight relief, with bumps and hollows where the image has been developed. The 
opposite surface (the film base) will be reflective and smooth.  
Insert film with the emulsion up. 

 

 

 

For odd sized film, see the section on Scanning Odd-Sized Film. 
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Scanning 35 mm Slides 

 

 

 

  

1. Choose the 35mm slide film holder. 
 

On a flat surface, load the slides into the 
holder, landscape oriented,   
shiny side face-down, and emulsion 
layer face-up. 

 
2. Give the scanner document glass a quick 

blast of canned air to clean the dust off. 
 
3. Lay the loaded 35 mm slide holder onto 

the document glass so that the arrow 
mark from the holder matches up with 
the arrow mark on the transparency 
guide.  
 
(You can use up to two loaded 35 mm 
slide holders if you have a lot of slides to 
scan.) 

 
4. Close the lid on the scanner. 
 
 
 
 
 
 
5. Open the EPSON Scan from the desktop 

Applications. An EPSON Scan window 
will open. 

 
6. Select Professional Mode from the 

Mode dropdown list. 
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7.  In the EPSON Scan window,  
Select the following: 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Click the Preview button.   
The scanner will create a preview and a Preview window will open. 

 
  

Original______________ 
Document Type:  Film 

Film Type:  Positive Film 

 

Destination__________ 
Image Type:   
48-bit Color for colour 
16-bit Grayscale for B&W 

Resolution:  2700 dpi 

 

Adjustments__________ 

Unsharp Mask should be 
checked. 
 Level: Low 

*No other Adjustment should be 
checked. 

 

Do not check the Thumbnail box. 

(the Thumbnail option tends to 
crop the image.) 
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9. In the Preview window, click and 
drag the mouse to draw a 
‘marquee’ box around each image, 
starting with the top, left image 
working down, and across to the 
bottom right.  

 

Ensure that the marquee is over 
the entire image with no cropping. 

 

Note: Any marquees you create will be 
scanned in the order you create the 
marquee.  

 

You can switch between each marquee 
crop box and make a box active by clicking 
one time inside an inactive crop box. An 
active crop box will have ‘marching ants’ 
around it. The active crop box can be modified by grabbing one of its edges and 
dragging it to a new position.  

 

Click the ‘Zoom’ button  to magnify the view of the active crop box. This will 
help you make precise adjustments. Click the ‘Preview’ tab to zoom back out and 
preview all our marquee selections. 

 

10. When you are finished creating marquees and adjusting the crop boxes, and are 
ready to scan, click the ‘All’ button in the Preview window.  
 

This will select all your marquees, and all the marquees should be active now 
and have an outline made in dashes around them. Only one will have ‘marching 
ants’ though. 

 

11. Click the Scan button at the bottom of the EPSON Scan window 
 to start the scan process. 

  



Part 2: Scanning with the Espon Expression 10000XL Scanner   12 

 

12. A File Save Settings dialog box will open. 
 
 
 

For Location,  

Other 
and click Choose to navigate to the 
appropriate folder on the network 
server. Use the browse button to 
navigate to it. 

 

For File Name, under  
Prefix, enter the file naming 
convention prefix. 

Change the Start Number to be 
whatever sequential number you are 
on. 

Set the Image Format to  
Type : TIFF (*.tif) 

 

Don’t check Overwrite any files with the same name.  

 
 
 
 

13. Click OK 

The scanner will start batch scanning any images you have marquee-ed.  

 
14. When it has finished, remove the Film Holder from the scanner glass 
15. Return the slides to their storage sheet. 
16. Turn off the scanner. 
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Scanning 35 mm Negative Filmstrips 

1. Choose the 35mm filmstrip holder.  
 

2. On a flat surface, remove the covers from the filmstrip holders. 

 

3. Load the filmstrips into the holder, starting from the bottom.  
Lay the filmstrips onto the holder shiny side face-down, and film emulsion side 
face-up. 
 
Make sure that the negatives are straight and sit securely in the holder.  
 
Lock the top part of the holder into place, making sure that you are not bending 
the negatives underneath, or obscuring any image with the holder frame. 
 

4. Give the scanner document glass and each side of the filmstrips in the holder a 
quick blast of canned air to clean the dust off. 
 

5. Lay the loaded 35 mm filmstrip 
holder onto the document 
glass so that the arrow mark 
from the holder matches up 
with the arrow mark on the 
transparency guide 
 
(You can use up to two loaded 
35 mm filmstrip holders if you 
have a lot of film to scan.) 
 
 

6. Close the lid on the scanner. 
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7. Open the EPSON Scan from the desktop Applications. An EPSON Scan window 
will open. 
 

8. Select Professional Mode from the 
Mode: dropdown list. 
 
 

9. In the EPSON Scan window,  
Select the following: 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
10. Click the Preview button.   

The scanner will create a preview and a Preview window will open. 

Original______________ 
Document Type:  Film 

Film Type:   
Color Negative Film for colour 
B&W Negative Film for B&W 

 

Destination__________ 
Image Type:   
48-bit Color for colour 
16-bit Grayscale for B&W 

Resolution:  2700 dpi 

 

Adjustments__________ 

Unsharp Mask should be 
checked. 
 Level: Low 

*No other Adjustment should be 
checked. 

 

Do not check the Thumbnail box. 

(the Thumbnail option tends to 
crop the image.) 
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11. In the Preview window, click and drag the mouse to draw a ‘marquee’ box 

around each image, starting with the top, right image working down, and across 
to the bottom left.  
 
Ensure that the 
marquee is over the 
entire image with 
no cropping. 
 

Note: Any marquees you 
create will be scanned in 
the order you create the 
marquee.  

 

You can switch between 
each marquee crop box 
and make a box active by 
clicking one time inside an 
inactive crop box. An active 
crop box will have 
‘marching ants’ around it. 
The active crop box can be 
modified by grabbing one 
of its edges and dragging it 
to a new position.  

 

Click the ‘Zoom’ button to 
magnify the view of the 
active crop box. This will help you make precise adjustments. Click the ‘Preview’ tab to 
zoom back out and preview all our marquee selections. 

 
12. When you are finished creating marquees and adjusting the crop boxes, and are 

ready to scan, click the ‘All’ button in the Preview window.  
 

This will select all your marquees, and all the marquees should be 
active now and have an outline made in dashes around them. Only one will have 
‘marching ants’ though. 
 
 

13. Click the Scan button at the bottom of the EPSON Scan window 
 to start the scan process. 
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14 A File Save Settings dialog box will open. 
 
 
 
For Location,  
 Other 
and click Choose to navigate to the 
appropriate folder on the network 
server. Use the browse button to 
navigate to it. 
 
For File Name, under  
Prefix, enter the file naming 
convention prefix. 
Change the Start Number to be 
whatever sequential number you are 
on. 
Set the Image Format to  
Type : TIFF (*.tif) 
 
Don’t check Overwrite any files with the same name.  
 
 
 
 

15 Click OK 
The scanner will start batch scanning any images you have marquee-ed.  
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Scanning medium format film (120/220, 2 ¼, or Brownie) 6x4, 
6x6, 6x7, 6x9 

 

1. Choose the medium format films holder.  
 

2. On a flat surface, open the cover o the film 
holders. 
 

3. Load the film into the holder. Lay the film onto 
the holder shiny side face-down, and film 
emulsion side face-up. 
 
Make sure that the negatives are straight and sit 
securely in the holder.  
 
Lock the top frame of the holder back into place, 
making sure that you are not bending the 
negatives underneath, or obscuring any image 
with the holder frame. 
 

4. Give the scanner document glass and each side 
of the filmstrips in the holder a quick blast of 
canned air to clean the dust off. 
 

5. Lay the loaded medium format film holder onto 
the document glass so that the arrow mark from 
the holder matches up with the arrow mark on 
the transparency guide 
 
(You can use up to two loaded medium format 
film holders if you have a lot of film to scan.) 
 
 

6. Close the lid on the scanner. 
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Open the EPSON Scan from the desktop 
Applications. An EPSON Scan window will 
open. 

 
7. Select Professional Mode from the 

Mode: dropdown list. 
 

8. In the EPSON Scan window,  
Select the following: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Original______________ 
Document Type:  Film 

Film Type:   
Color Negative Film for colour 
B&W Negative Film for B&W 

 

Destination__________ 
Image Type:   
48-bit Color for colour 
16-bit Grayscale for B&W 

Resolution:   
1632 dpi for 6x6 
1088 dpi for 6x9 
775 dpi for 6x12 
See Resolution Size table for other 
sizes 

 

Adjustments__________ 
Unsharp Mask should be 
checked. 
 Level: Low 

*No other Adjustment should be 
checked. 

 

Do not check the Thumbnail box. 

(the Thumbnail option tends to 
crop the image.) 
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9. Click the Preview button.   
The scanner will create a preview and a Preview window will open. 

10. In the Preview window, click and drag the mouse to draw a ‘marquee’ box 
around each image, 
starting with the top, 
right image working 
down, and across to 
the bottom left.  
 
Ensure that the 
marquee is over the 
entire image with no 
cropping. 
 

Note: Any marquees you 
create will be scanned in the 
order you create the marquee.  

 

You can switch between each 
marquee crop box and make a 
box active by clicking one time 
inside an inactive crop box. An 
active crop box will have 
‘marching ants’ around it. The 
active crop box can be 
modified by grabbing one of its 
edges and dragging it to a new 
position.  

 

Click the ‘Zoom’ button to magnify the view of the active crop box. This will help you 
make precise adjustments. Click the ‘Preview’ tab to zoom back out and preview all our 
marquee selections. 

 
11. When you are finished creating marquees and adjusting the crop boxes, and are 

ready to scan, click the ‘All’ button in the Preview window.  
 
This will select all your marquees, and all the marquees should be active now 
and have an outline made in dashes around them. Only one will have ‘marching 
ants’ though. 
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12. Click the Scan button at the bottom of the EPSON Scan window 
 to start the scan process. 
 
 

14. A File Save Settings dialog box will open. 
 
For Location,  
 Other 
and click Choose to navigate to the 
appropriate folder on the network 
server. Use the browse button to 
navigate to it. 
 
For File Name, under  
Prefix, enter the file naming 
convention prefix. 
Change the Start Number to be 
whatever sequential number you are 
on. 
Set the Image Format to  
Type : TIFF (*.tif) 
 
Don’t check Overwrite any files with the same name.  
 
 
 
 

15. Click OK 
The scanner will start batch scanning any images you have marquee-ed.  
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Scanning 4x5 inch film 

1. Choose the 4x5 inch format films holder.  
 

2. On a flat surface, open the cover o the film holders. 
 

3. Load the film into the holder. Lay the film onto the 
holder shiny side face-
down, and film 
emulsion side face-up. 
 
Make sure that the 
negatives are straight 
and sit securely in the 
holder.  
 
Lock the top frame of 
the holder back into 
place, making sure that you are not bending 
the negatives underneath, or obscuring any image with the holder frame. 
 

4. Give the scanner document glass and each side of the film in the holder a quick 
blast of canned air to clean the dust off. 
 

5. Lay the loaded 4x5 inch format film holder 
onto the document glass so that the arrow 
mark from the holder matches up with the 
arrow mark on the transparency guide 
 
(You can use up to two loaded 4x5 inch 
format film holders if you have a lot of film to 
scan.) 
 
 

6. Close the lid on the scanner. 

 

 

7. Open the EPSON Scan from the desktop Applications. An EPSON Scan window 
will open. 
 

8. Select Professional Mode from the 
Mode: dropdown list. 
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9. In the EPSON Scan window,  
Select the following: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
10. Click the Preview button.   

The scanner will create a preview and a Preview window will open. 

 

 

  

Original______________ 
Document Type:  Film 

Film Type:   
Color Negative Film for colour 
B&W Negative Film for B&W 

 

Destination__________ 
Image Type:   
48-bit Color for colour 
16-bit Grayscale for B&W 

Resolution:   
720 dpi for 4x5 inch 
 

 

Adjustments__________ 
Unsharp Mask should be 
checked. 
 Level: Low 

*No other Adjustment should be 
checked. 

 

Do not check the Thumbnail box. 

(the Thumbnail option tends to 
crop the image.) 
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11. In the Preview window, click and drag the mouse to draw a ‘marquee’ box 
around each image, starting with the top, right image working down, and across 
to the bottom left.  
 
Ensure that the 
marquee is over the 
entire image with no 
cropping. 
 

Note: Any marquees you 
create will be scanned in the 
order you create the 
marquee.  

 

You can switch between each 
marquee crop box and make 
a box active by clicking one 
time inside an inactive crop 
box. An active crop box will 
have ‘marching ants’ around 
it. The active crop box can be 
modified by grabbing one of 
its edges and dragging it to a 
new position.  

 

Click the ‘Zoom’ button to 
magnify the view of the active 
crop box. This will help you 
make precise adjustments. Click the ‘Preview’ tab to zoom back out and preview all our 
marquee selections. 

 
12. When you are finished creating marquees and adjusting the crop boxes, and are 

ready to scan, click the ‘All’ button in the Preview window.  
 
This will select all your marquees, and all the marquees should be active now 
and have an outline made in dashes around them. Only one will have ‘marching 
ants’ though. 
 
 

13. Click the Scan button at the bottom of the EPSON Scan window 
 to start the scan process. 
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14. A File Save Settings dialog box will open. 
 
For Location,  
 Other 
and click Choose to navigate to the 
appropriate folder on the network 
server. Use the browse button to 
navigate to it. 
 
For File Name, under  
Prefix, enter the file naming 
convention prefix. 
Change the Start Number to be 
whatever sequential number you are 
on. 
Set the Image Format to  
Type : TIFF (*.tif) 
 
Don’t check Overwrite any files with the same name.  
 
 
 
 

15. Click OK 
The scanner will start batch scanning any images you have marquee-ed.  
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Scanning Odd–Sized Film (Slides and Negatives)  

This process is for loose non-standard sized film and slides, for which we do not have a 
film holder. Using the transparency mode, the film or slide is placed directly onto the 
glass document table. 

 

1. If the film or slide is mounted to a frame, 
measure the width of the frame. 
 
Example 1: 
6 x 6 cm color slide.  There is no film 
holder for this format. The width of the 
frame is 1.5 mm. (see photo) 
 
Example 2: 
An odd sized B&W negative. There is no 
film holder to match the size.  
Measure the longest side of the negative. 
The longest side of this negative is 7” 
inches. 
 
 

2. Give the scanner document glass and 
each side of the film a quick blast of canned air to clean the dust off. 
 
 

3.  Place the film or slide directly 
onto the glass document table, 
shiny side face-down, and film 
emulsion side face-up. Alight 
the film or slide so that it 
matches up with the end 
corner on the transparency 
guide 
 
(You can place multiple films 
on the table if you have a lot of 
film to scan.) 
 
 

4. Close the lid on the scanner. 
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5. Open the EPSON Scan from the desktop Applications. An EPSON Scan window 
will open. 
 

6. Select Professional Mode from the 
Mode: dropdown list. 

 

7. In the EPSON Scan window,  
Select the following: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Original______________ 
Document Type:  Film 

Film Type:   
Positive Film for slides 
Color Negative Film for colour 
B&W Negative Film for B&W 

 

Destination__________ 
Image Type:   
48-bit Color for colour 
16-bit Grayscale for B&W 

Resolution:   
Use the Resolution Size Table 
Ex 1:  
6x6 cm colour Slide= 1632 dpi 
Ex 2:  
4x7 inch B&W Negative = 514 dpi 

 

Adjustments__________ 
Unsharp Mask should be checked. 
 Level: Low 

*No other Adjustment should be 
checked. 

 

Do not check the Thumbnail box. 

(the Thumbnail option tends to crop 
the image.) 
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8. Click the Preview button.   
The scanner will create a preview and a Preview window will open. 
 

9. Click the  Manual Focus button in the Preview window.  
 
Enter a Focus Position value. 
 
Because we are not using a film holder, and placing the original directly on the 
document table, we need to specify where the scanner should to focus. 
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Example 1 
6 x 6 cm Mounted Slide placed directly on the document table. 
Frame measured 1.5 mm in total width. 
 
Focus Position:  0.75   (half of the frame width). 
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Example 2  
Odd-Sized B&W Negative placed directly on the document table. 
 
Focus Position: 0.0  (directly on the glass document table). 
 

 
 

10. In the Preview window, click 
and drag the mouse to draw a 
‘marquee’ box around each 
image, starting with the top, 
right image working down, 
and across to the bottom left.  
 
Ensure that the marquee is 
over the entire image with no 
cropping. 
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Note: Any marquees you create will be scanned in the order you create the marquee.  

 

You can switch between each marquee crop box and make a box active by clicking one 
time inside an inactive crop box. An active crop box will have ‘marching ants’ around it. 
The active crop box can be modified by grabbing one of its edges and dragging it to a 
new position.  

 

Click the ‘Zoom’ button to magnify the view of the active crop box. This will help you 
make precise adjustments. Click the ‘Preview’ tab to zoom back out and preview all our 
marquee selections. 

 

11. When you are finished creating marquees and adjusting the crop 
boxes, and are ready to scan, click the ‘All’ button in the Preview 
window.  
 
This will select all your marquees, and all the marquees should be active now 
and have an outline made in dashes around them. Only one will have ‘marching 
ants’ though. 
 

12. Click the Scan button at the bottom of the EPSON Scan window 
 to start the scan process. 
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13. A File Save Settings dialog box will open. 
 
For Location,  
 Other 
and click Choose to navigate to the 
appropriate folder on the network 
server. Use the browse button to 
navigate to it. 
 
For File Name, under  
Prefix, enter the file naming 
convention prefix. 
Change the Start Number to be 
whatever sequential number you are 
on. 
Set the Image Format to  
Type : TIFF (*.tif) 
 
Don’t check Overwrite any files with the same name.  
 

14. Click OK 
The scanner will start batch scanning any images you have marquee-ed.  
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SCANNING PHOTOGRAPHIC PRINTS AND DOCUMENTS 

Use the Document Mode for Reflective (Non-Film) Scanning 

Raise the scanner lid and check that the reflective document mat is attached and that 
the transparency guide is removed. 

If it is not  

1. Remove the transparency guide. 

2. Insert the white reflective document mat, by sliding it upward. 

And then lowering and inserting the bottom edge into the slot.  
3. Place the document, artwork, or photographic print face down on the document 

table and close the scanner lid. 
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Scanning Black-and White Photographic Prints 

1. Examine the B&W photograph. If the photograph is in good condition proceed.   
 

If the image has faded and the pigment is not black-and-white, but has a 
significant color cast or color tone, then scan the black-and-white 
photograph as if it were a color photograph (see process for Scanning 
Color Photographic Prints and Artworks). 

 
2. Measure the longest side of the image in the photograph to determine scanning 

resolution size. (See Resolution Size Table).  
 
Example  
This image measures 4 inches, or 10 cm along the longest side. 
The scan resolution should be set to  
800 dpi (for printing an 8” x 10” of the image at 600 dpi) or  
400 dpi (for printing an 8” x 10” of the image at 300 dpi). 
 

3. Give the scanner document glass and the photograph a quick blast of canned air 
to clean the dust off. 
 

4.  Place the photograph 
directly onto the glass 
document table face 
down.  
 
Don’t place the 
photograph directly on 
the edge, but leave a 
1.5-2mm gap from the 
edge of the glass 
document table. 
 
Note: The area with a 
width of 1.5 mm from 
the edge cannot be 
scanned.  
 

5. Close the lid on the scanner. 
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6. Open the EPSON Scan from the desktop Applications. An EPSON Scan window 
will open. 
 

7. Select Professional Mode from the 
Mode: dropdown list. 

 

8. Click the Configuration button at the bottom of the EPSON Scan window. 
Check that it is set to Gamma 2.2 for Black-and-White scanning.  
(See Color  Profile Setup ) 
Click OK if you need to change the settings, or click Cancel if you don’t need to 
change the settings 

 

9. In the EPSON Scan window,  
Select the following: 
 

 

 
 
 
 
 
 
 

  

Original______________ 
Document Type:  Reflective 

Document Source:  
                      Document Table 

Auto Exposure Type:  Photo  

 

Destination__________ 
Image Type:   
16-bit Grayscale for B&W 

Resolution:   
Use the Resolution Size Table 
Example:  
800 dpi (for printing an 8” x 10” of 
the image at 600 dpi) or  
400 dpi (for printing an 8” x 10” of 
the image at 300 dpi) 
 

Adjustments__________ 
Unsharp Mask should be checked. 
 Level: Low 

*No other Adjustment should be 
checked. 

 

Do not check the Thumbnail box. 

(the Thumbnail option tends to crop 
the image.) 
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10. Click the Preview button.   
The scanner will create a preview and a Preview window 
will open. 
 

11. In the Preview window, click and drag the mouse to draw a ‘marquee’ box 
around each photograph including any border of the physical photograph. 
 
Ensure that the marquee 
is over the entire 
photograph with no 
cropping. 
 

Note: Any marquees you create 
will be scanned in the order you 
create the marquee.  

 

You can switch between each 
marquee crop box and make a 
box active by clicking one time 
inside an inactive crop box. An 
active crop box will have 
‘marching ants’ around it. The 
active crop box can be modified 
by grabbing one of its edges and 
dragging it to a new position.  

 

Click the ‘Zoom’ button to 
magnify the view of the active 
crop box. This will help you make 
precise adjustments. Click the 
‘Preview’ tab to zoom back out 
and preview all our marquee selections. 

 
12. When you are finished creating marquees and adjusting the crop 

boxes, and are ready to scan, click the ‘All’ button in the Preview 
window.  
 
This will select all your marquees, and all the marquees should be active now 
and have an outline made in dashes around them. Only one will have ‘marching 
ants’ though. 
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13. Click the Scan button at the bottom of the EPSON Scan window to start the scan 
process. 
 

 

14. A File Save Settings dialog box will open. 
 
For Location,  
 Other 
and click Choose to navigate to the 
appropriate folder on the network 
server. Use the browse button to 
navigate to it. 
 
For File Name, under  
Prefix, enter the file naming 
convention prefix. 
Change the Start Number to be 
whatever sequential number you are 
on. 
Set the Image Format to  
Type : TIFF (*.tif) 
 
Don’t check Overwrite any files with the same name.  
 
 
 

15. Click OK 
The scanner will start batch scanning any images you have marquee-ed.  
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Scanning Color Photographic Prints and Artworks 

1. Measure the longest side of the image in the photograph or the longest side of 
the artwork to determine scanning resolution size. (See Resolution Size Table).  
 
Example  
This photograph with no border measures 5 x 3.5 inches, or 12.5 cm along the 
longest side. 
The scan resolution should be set to  
1440 dpi (for printing an 8” x 10” of the image at 600 dpi) or  
720 dpi   (for printing an 8” x 10” of the image at 300 dpi). 
 

2. Give the scanner document glass and the photograph a quick blast of canned air 
to clean the dust off. 
 

3.  Place the photograph 
directly onto the glass 
document table face 
down.  
 
Don’t place the 
photograph directly on 
the edge, but leave a 
1.5-2mm gap from the 
edge of the glass 
document table. 
 
Note: The area with a 
width of 1.5 mm from 
the edge cannot be 
scanned.  
 

4. Close the lid on the scanner. 
 
 

5. Open the EPSON Scan from the desktop Applications. An EPSON Scan window 
will open. 
 

6. Select Professional Mode from the 
Mode: dropdown list. 
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7. Click the Configuration button at the bottom of the EPSON Scan window. 
Check that it is set to Adobe RGB for colour scanning.  
(See Color  Profile Setup ) 
Click OK if you need to change the settings, or click Cancel if you don’t need to 
change the settings 

 

 

8. In the EPSON Scan window,  
Select the following: 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Original______________ 
Document Type:  Reflective 

Document Source:  
                      Document Table 

Auto Exposure Type:  Photo  

 

Destination__________ 
Image Type:   
48-bit Color for colour 

Resolution:   
Use the Resolution Size Table 
Example:  
1440 dpi (for printing an 8” x 10” of 
the image at 600 dpi) or  
720 dpi (for printing an 8” x 10” of 
the image at 300 dpi) 
 

Adjustments__________ 
Unsharp Mask should be checked. 
 Level: Low 

*No other Adjustment should be 
checked. 

 

Do not check the Thumbnail box. 

(the Thumbnail option tends to crop 
the image.) 
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9. Click the Preview button.   
The scanner will create a preview and a Preview window 
will open. 
 

10. In the Preview window, click and drag the mouse to draw a ‘marquee’ box 
around each photograph including any border of the physical photograph.  
 
Ensure that the 
marquee is over the 
entire photograph with 
no cropping. 
 

Note: Any marquees you 
create will be scanned in the 
order you create the marquee.  

 

You can switch between each 
marquee crop box and make a 
box active by clicking one time 
inside an inactive crop box. An 
active crop box will have 
‘marching ants’ around it. The 
active crop box can be 
modified by grabbing one of 
its edges and dragging it to a 
new position.  

 

Click the ‘Zoom’ button to 
magnify the view of the active 
crop box. This will help you 
make precise adjustments. 
Click the ‘Preview’ tab to zoom back out and preview all our marquee selections. 

 
11. When you are finished creating marquees and adjusting the crop 

boxes, and are ready to scan, click the ‘All’ button in the Preview 
window.  
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This will select all your marquees, and all the marquees should be active now 
and have an outline made in dashes around them. Only one will have ‘marching 
ants’ though. 
 

12. Click the Scan button at the bottom of the EPSON Scan 
window to start the scan process. 
 
 
 

13. A File Save Settings dialog box will open. 
 
For Location,  
 Other 
and click Choose to navigate to the 
appropriate folder on the network 
server. Use the browse button to 
navigate to it. 
 
For File Name, under  
Prefix, enter the file naming 
convention prefix. 
Change the Start Number to be 
whatever sequential number you are 
on. 
Set the Image Format to  
Type : TIFF (*.tif) 
 
Don’t check Overwrite any files with 
the same name.  
 
 

14. Click OK 
The scanner will start batch scanning any images you have marquee-ed.  
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Scanning Ledgers (and Oversize Drawings) 

1. Measure the longest side of the ledger or drawing to determine scanning 
resolution size. (See Resolution Size Table).    

2. One ledger page fits on the document table. 
(Drawings that are larger than the document table must be captured with 
multiple scans.) 
 
Stitching software requires some overlap of image to successfully match the 
images together, 
So, scan the page plus 1/3rd of the adjacent page. 
 
Example  
Ledger 1 measures 14” x 8” inches. 14”inches along the longest side. 
The scan resolution should be set to  
200 dpi   (for printing an10” x 5.7” of the image at 300 dpi). 
 

3. Give the scanner document glass and the ledger page a quick blast of canned air 
to clean the dust off. 
 

4. Place the foam block next to the scanner, then place the ledger on the scanner 
so that the part of the 
ledger that hangs off 
the scanner is 
supported by the foam. 
 

5.  Place the ledger 
directly onto the glass 
document table face 
down.  
 
Don’t place the ledger 
page directly on the 
edge, but leave a 1.5-
2mm gap from the 
edge of the glass 
document table. 
 
Note: The area with a width of 1.5 mm from the edge cannot be scanned.  
 

6. Close the lid on the scanner as best you can. 
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7. Open the EPSON Scan from the desktop Applications. An EPSON Scan window 
will open. 
 

8. Select Professional Mode from the 
Mode: dropdown list. 

 

9. Click the Configuration button at the bottom of the EPSON Scan window. 
Check that it is set to Adobe RGB for colour scanning.  
(See Color  Profile Setup ) 
Click OK if you need to change the settings, or click Cancel if you don’t need to 
change the settings 

 

10. In the EPSON Scan window,  
Select the following: 
 

 

 
 
 

 

 

  

Original______________ 
Document Type:            Reflective 

Document Source:  
                               Document Table 

Auto Exposure Type:  Document  

 

Destination__________ 
Image Type:   
24-bit Color  

Resolution:  200 dpi 
 
Ledger 14” x 8” inches:  
200 dpi (for printing an 10” x 5.7” of 
the image at 300 dpi) 
or use the Resolution Size Table 
for other sizes. 

Adjustments__________ 
Unsharp Mask should be checked. 
 Level: Medium 

*No other Adjustment should be 
checked. 

 

Do not check the Thumbnail box. 

(the Thumbnail option tends to crop 
the image.) 



Part 2: Scanning with the Espon Expression 10000XL Scanner   43 

 
11. Click the Preview button.   

The scanner will create a preview and a 
Preview window will open. 
 

12. In the Preview window, click and drag the mouse to draw a ‘marquee’ box 
around the entire ledger page,  
plus about 1/3 of the adjacent page.  
 
Ensure that the marquee is over the entire page with no cropping. 
 

 
 

13. When you are finished creating marquee and adjusting the crop box, and are 
ready to scan, click the Scan button at the bottom of the EPSON Scan window to 
start the scan process. 
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14. A File Save Settings dialog box will open. 
 
For Location,  
 Other 
and click Choose to navigate to 
the appropriate folder on the 
network server. Use the browse 
button to navigate to it. 
 
For File Name, under  
Prefix, enter the file naming 
convention prefix. 
Ledger #_pg 
Change the Start Number to be 
whatever sequential page number 
you are on. 
 
Set the Image Format to  
Type : TIFF (*.tif) 
 
Don’t check Overwrite any files with the same name.  
 
 

15. Click OK 
The scanner will start scanning any images you have marquee-ed.  
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Stitching Ledger Pages, Oversize Documents or Multiple 
Images Together 

Use any of the previous media-appropriate scanning processes to scan the images you 
will use to stitch together. 

 

Using the Photoshop Photomerge to Stitch All Images 
 

1. In Photoshop, from the menu bar, 
chose 
File  -> Automate -> Photomerge 
 
 
 
 
 
 
 
 
 
 
 
 
The Photomerge dialog box will 
open. 
 

2. Browse to find all the files you want to use to stitch together 
Select all the images you want to use, and click Open. 
 

 



Part 2: Scanning with the Espon Expression 10000XL Scanner   46 

 
 

3. Select the appropriate stitching algorithm 
If one algorithm does not work, try a different algorithm. 
Layout :  

Perspective, Cylindrical, Spherical = correct the perspective (wrap 
around a 3d plane mapping).  
Use where the vanishing point location changes in each photo. 
Later you can use tone blending to hide seams. 

Collage & Reposition = just layer images on top of each other, no 
perspective adjustments. 

Auto = when you don’t know. 
 

 
 

4. Chose Spherical 
Check Blending Images Together. 
Check Vignette Removal only if there is wide angle vignetting 
Check Geometric Distortion Correction (Barrel or pin) only if it is there. 
 

5. Hit OK and wait.... 
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6. Each image is being opened and copied into a individual layer in a new 

Photoshop document, and then it is processed, aligned and overlapped, and 
blended so seams don’t show. 
 

 
 

7. When it’s done, evaluate the image. Preview can make the blended images or 
edges look bad, it will look better in the final image. 

8. Flatten the image. From the menu bar, chose: 
Layer -> Flatten Image 
 

Cropping the Stitched Image, and using Fill  
 

9. Alight the image if needed using the ruler.  
Drag the ruler line along one of the lines on the ledger 
from far left to far right. 
Then click the Straighten button. 
 

10. Crop the image using the Crop Tool.  
You may include some blank areas around the edges (in 
CS5). 
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Using the Content Aware Fill to Clean Up Edges of Image 
If you include blank areas, you may use the Content – Aware Fill to fill the blank areas 
around the edges of the image. 

 
11. Using the Magic Wand, select an empty area 

32 tolerance, anti-alias, contiguous. 
 
If the empty area is near some irregular patterned 
area, you can make a bigger selection to sample 
from by adjusting the selection edge. 
 

12. From the menu, chose, 
Select -> Refine Edge 
 
The Refine Edge dialog box opens 
 
View mode: Marching Ants 
 
Adjust Edge :  Shift Edge: move to +50  
 
Click OK 
 
 
 
 
 
 
 
 
 

13. Fill the blank area.  From the menu, chose 
Edit -> Fill -> 
The Fill dialog box will open. 

14. Use Content-Aware 
Blending Mode: Normal 
Opacity: 100% 
Click Okay 
 

15. Wait… 
 

16. Deselect the area. 
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Correct or Repair Any Artifacts, Repeating Patterns or Bad Seams 
 

17. Fix any weird artifacts, repeating patterns, 
seams 
 

18. Use the Clone stamp tool 
Mode: Normal 
Opacity: 100% Flow: 100% 
 

19. Sample (opt key) and then brush over. 
 

Tonal Adjustments 
Adjust the contrast and levels. 

 
20. Create an adjustment layer for Levels.  

 
 
Click the Adjustment Layer icon at the 
bottom of the Layers pallet. 
 
 
 
 
 
 
This will create an adjustment layer, and open the Levels Adjustment dialog 
box. 
 
 
 
 

21. Bring in the blacks, highlights, 
and adjust the mid-tones to give 
the image more contrast. 
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Corrections and Cleanup 
Remove and correct any spots or scratches from the image. 

 
 
 

22. Use the Clone Stamp tool, or the Spot Healing Brush Tool as needed. 
 
 
 
 
 
 
 
 
 
See Post-Scanning Processes for removing scratches and spots. 
 

Save the Final Merged Image 
 

23. Save the image. 
From the menu, chose, 
File -> Save  or  Save As 
 
Give it a new file name that reflects the merged pages: 
ie., Ledger1_pgs6-7.tiff 
 

 



 

 

Part 3: 
Post-Scanning  
Image Adjustment 
and Correction 

 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
These guidelines provide technical instructions for the use of scanners and the standard creation of digital 
master image files.  
Prepared by Elizabeth Padilla, (23 Feb 2011) 
Updated by Ann Stevenson (28 May 2015; 10 October 2015) 
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POST-SCANNING WORKFLOW PROCESSES 

For each object scanned, you will produce two files: 

Digital Master = the adjusted, but uncorrected scanned image file, frequently 
called the uncorrected master in this manual. 
Access Master = a copy of the digital master which is corrected to enhance 
access and/or downsized for publishing or printing. Also called the corrected 
master in AHHLA documentation.   

Adjustments to Digital Master (Authenticity) 

Digitization must strive to preserve to the greatest extent possible the authenticity and 
integrity of the original information.  

Adjustments made to the Digital Master image are made to optimize image quality and 
bring all images to a common rendition, to produce the most accurate visual 
representation of the original.  

Post-Scanning Adjustments include: 

 Cropping the image 

 Rotating and straightening the image 

 Assigning a color profile 

Corrections to Access Master (Enhancement) 

Digital enhancements may be performed only on copies of the digital master file to 
improve access. The digital master file must be kept unaltered. 

Corrections are made to an Access Master, or derivative file of the Digital Master image 
to enhance the visual image and make it more accessible and viewable, and for the 
purpose of reproducing for specific print or display.  

Post-Scanning Corrections include: 

 Tone correction (levels, tone balance, contrast, highlights, shadows) 

 Color correction (white balance, saturation) 

 Touching up, dust and scratch removal 

 Sharpening the image 

Access  master – Corrected Derivative of Digital Master Scan 
Access versions of the Digital Master image file can be produced for other purposes with 
different reproduction renderings. These versions include any corrected or downsized 
derivatives of the Digital Master. 
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Image Adjustments to Digital Master in Photoshop  

1. Open the uncorrected Master file in Photoshop CS5.  
 

Start Photoshop from the Applications on the desktop and 
navigate to the file through the menu File->Open. 
Or left-mouse click the image file in Finder, and select Open 
with…Adobe Photoshop CS5 

 
 
2. Straighten and/or rotate the image as necessary. 
 

If you need to rotate the image by 
90° or 180°  
then from the menu bar, choose  
Image->Image Rotation-> 

180° 
90° CW (clockwise) 
90° CCW (counter-clockwise) 

 
 
 
 
 
 
For more precise straightening of the image, 
Select the Ruler Tool from the Tool window by pressing 
the bottom right corner of Eyedropper Tool, and 
mousing down to the Ruler Tool 
 
Using the Ruler Tool, click and drag from the bottom 
right horizontal corner of the image and drag the cursor 
to the bottom left horizontal corner (drawing a line that 
should represent the horizon). 
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You should see a Straighten button at the top, in the options bar for 
the Ruler tool.  
Click the Straighten button, and it will straighten the image. 
 

 
3. Crop the image as necessary.  
 

To crop the image, 
Select the Crop Tool from the 
Tool window. 
 
Drag the crop box around the 
image. Adjust the crop by 
dragging in and out from any 
of the edges.  
 
Leave a slight border around 
the photograph. Include the 
photograph’s border if it has 
one. 
 
Press the Return key to make 
the crop. 

 
 
 
4. Assign the color profile in 

Photoshop. 
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From the menu bar, choose  Edit->Convert to Profile 
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For black-and-white images choose: Gray Gamma 2.2 
 

 
 
 
For color images choose: Adobe RGB (1998) 
 

 
 
Click OK 

 
5. Save the file.   

 
From the menu bar, choose 
File->Save 
 
You are saving the original scanned file with these adjustments. 
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POST-SCANNING CORRECTIONS TO THE ACCESS MASTER 

Create an Access Copy in Photoshop  

1. Open the adjusted Master file in Photoshop CS5.  
 

Start Photoshop from the Applications on the desktop and 
navigate to the file through the menu File->Open. 
Or left-mouse click the image file in Finder, and select Open 
with…Adobe Photoshop CS5 

 
2. Create a copy, or derivative, of the Master to start correcting. 
 

From the menu bar, choose  
File->Save As… 
 
In the Save As dialog box 
 
Use the same master filename, but 
add a letter ‘c’ to the end. 
 
Where: Save to the project directory, 
corrected image sub-directory 
 
Everything else is the same,  
Format: TIFF 
Embed Color Profile  
Adobe  RGB (1998) for color,  
Gray Gamma 2.2 for black-and-white. 
 

3. When the TIFF Options dialog box opens, select the 
default settings :  
Image Compression : None 
Pixel Order : Interleaved (RGBRGB) 
Byte Order : Macintosh 
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Correcting Tone and Contrast of Black-and-White Images 1 

1. In Photoshop, bring up the Curves tool from the menu bar, choose  
Image->Adjustments->Curves 
or use the keyboard shortcut ⌘ + m 
 
 

2. Check the Show Clipping box 
Check the Light (0-255) radio button. 
 
 

 

  

                                                        
1 If you are familiar with using Adjustment layers process (Adjustment panel on the right) rather than the 
Curves tool, please do so.  
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3. Adjust the darks by moving the left slider toward data on the histogram. With 

clipping turned on, you will know when you go to far when data starts to show 
up (it is being clipped too far) 

 
 
 
 

4. Adjust the lights by moving the right slider toward data on the histogram. With 
clipping turned on, ignoring the white border around the image, you will know 
when you go to far when data starts to show up within the image (it is being 
clipped too far) 
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5. Turn off Show Clipping by unchecking the box.  You will see changes made to 
the image.  Next, to add a bit of contrast, put an S curve in the curves line, by 
adding a point for highlights and pulling it up and left (just a bit), and by adding 
a point for darks and pulling it down and to the right (just a bit). 
 

 
6. Click OK 

 

 
7. Before curves adjustments and after curves adjustment. 
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Correcting White Balance for Colour Images. 

1. Open the Access copy in Photoshop. 
 

2. Analyse the image. Often older images will develop a colour cast : Is it too red, 
or too green or too blue?  Look for something in the image that you think might 
be or should be white.  Was there a piece of white paper or an item of clothing 
that was probably white?  If there is nothing white, you can look for something 
that could be neutral grey.  Identify with your eye something in the image that 
should be white or grey.   
 
NOTE:  You must use your judgment. If the photograph was taken at sunset, 
there would naturally be a colour cast of pink or yellow, that is not a flaw in the 
scan. If the day was overcast, then the sky would not be blue, but more grey. 
Was the photograph taken indoors under fluorescent giving a blue tone, or 
tungsten light giving an amber tone? Don’t correct colour to an absolute 
formula, but rather, consider the lighting situation when the image was taken, 
and make compensations for the colour hues in these situations. 

In the sample image shown, there appears to be a reddish colour cast across 
the whole image.  I’ve circled in red, a piece of paper on the ground, which I 
think could be white.  There is also possibly the grey of the man’s jacket in the 
foreground.   

3.  Make sure your INFO panel is open and visible.  
 
If not, open it from the menu bar Window -> Info 
And make sure the INFO panel options are set to show RGB values. 
 

4. In Photoshop, select the eyedropper Tool (I) from the Toolbar, and choose the 
option 
Sample Size: 5 by 5 average. 
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5. With the eyedropper 
tool, mouse over the 
area of the image that 
you think is white, or 
neutral grey. Shift and 
click over the white 
and/or neutral grey 
area(s) to create a 
sample (#1).  
You can create 
multiple samples. 
 

6. Look at the INFO 
panel to evaluate the 
RGB colour values of 
this sample.  

 

In this sample case, 
when we mouse over 
the area in the image 
that we think is white, 
we are seeing that the 
red (R) value (217) is 
higher than the G 
value (210), and the G 
value is higher than 
the B value (197).  
Indeed this image has 
a red colour cast. 
 
In a true white or 
neutral grey, all RGB 
values should be the same value (or very close). 
 
In our example we have to decrease the red tones and possibly bring up the 
blue tones. (It was a cloudy day, and there could have been less blue light.) 
 

7. To correct the colour cast we will use the Curves adjustment.  
In Photoshop, bring up the Curves tool from the menu bar, choose  
Image->Adjustments->Curves 
or use the keyboard shortcut ⌘ + m 
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8. We are first adjusting the 
reds, so we will select the 
red Channel to start work. 
In the Curves dialog box 
change the Channel to 
Red 
Channel: Red 
 

9. Once we are in the red 
channel we can decrease 
red by clicking in the 
middle of the diagonal 
line on the histogram, and 
dragging down, watching 
our #1 values in the INFO 
panel.  
 
The first value is the 
original value, the second 
value is the changed value 
(Ex :#1  R:217/210). Drag till the R: value number matches the G value. 
 

10. The Blue values is low, but it was a cloudy day, play around with increasing blue 
a little bit, but not so much that the overall image becomes too blue. 
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11.  Click Ok. 

 

 

12. Look at the overall RGB tones. Does it look balanced? Are the things that should 
be red, red? Are the things that should be green, green? Are the things that 
should be blue, blue?  

 

 

We have adjusted the white balanced on the image to the best of our ability. We 
weren’t there when the photo was taken, and don’t know the conditions. We don’t 
always have a true white to work from.   The best we can do is remove any strong colour 
casts to make the image more accessible. 
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Correcting the Tone and Contrast for Colour Images 

NOTE: The process of correcting the tone and contrast of colour images is exactly the 
same as the process for correcting black-and-white tone and contrast, with the 
exception that we must perform the process in each of the three colour channels; Red, 
Blue, and Green. 

 

1. In Photoshop, bring up the Curves tool from the menu bar, choose  
Image->Adjustments->Curves 
or use the keyboard shortcut ⌘ + m 
 

 

2. We will adjust each of the colour Channels. 
Start with the Red Channel by selecting  
Red from the Channel dropdown 
Channel : Red 
 

3. In the Curves dialog box, Channel : Red 
Check the Show Clipping box 
Check the Light (0-255) radio button. 
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4. Adjust the dark reds by moving the left slider in toward data on the histogram. 
With Show Clippings checked, you will know when you go to far when you start 
to see data show up as black marks (it is being clipped too far). See below. 

 

5. Adjust the light reds by moving the right slider in toward data on the histogram. 
With Show Clippings checked, ignoring the border around the image, you will 
know when you go to far when you start to see data show up as red marks (it is 
being clipped too far). See below. 
 

 
 

6. Un-Check the Show Clippings box, to see the results. 
 

7. Next we will adjust the Green Channel 
by selecting Green from the Channel dropdown 
Channel : Green 

 

8. In the Curves dialog box, Channel: Green 
Check the Show Clipping box 
Check the Light (0-255) radio button 
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9. Adjust the dark greens by moving the left slider in toward data on the histogram. 

With Show Clippings checked, you will know when you go to far when you start 
to see data show up as black marks (it is being clipped too far). See below. 
 

 
10. Adjust the light greens by moving the right slider in toward data on the   

histogram. With Show Clippings checked, ignoring the border around the image, 
you will know when you go to far when you start to see data show up as green 
marks (it is being clipped too far). See below. 
 

 
11. Un-Check the Show Clippings box, to see the results. 

 
12. Next we will adjust the Blue Channel 

by selecting Blue from the Channel dropdown 
Channel : Blue 

 

13. In the Curves dialog box, Channel: Blue 
Check the Show Clipping box 
Check the Light (0-255) radio button 
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14. Adjust the dark blues by moving the left slider in toward data on the histogram. 
With Show Clippings checked, you will know when you go to far when you start 
to see data show up as black marks (it is being clipped too far). See below. 

 

15. Adjust the light blues by moving the right slider in toward data on the histogram. 
With Show Clippings checked, ignoring the border around the image, you will 
know when you go to far when you start to see data show up as blue marks (it is 
being clipped too far). See below. 

 

16. Un-Check the Show Clippings box, to see the results. 
 

17. Look at the overall results in the Channel RGB 
by selecting RGB from the Channel dropdown 
Channel : RGB 
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The image seems to have a good overall contrast and tone. We might want to 
bring in a bit more light to some of the mid-tone areas.  
 

 
 
This can be achieved in the RGB channel by dragging up on the diagonal line in 
the histogram from the centre. 
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18. The final image: 

 

 

19. Save the file. 
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Cleaning Up Spots and Scratches. Corrections. 

Use the Spot Healing Brush Tool  

The Spot Healing Brush Tool will clean up small unwanted marks from an image 
more easily than the standard Healing Brush. 

This brush will make its own sample from the pixels around the mark and match in the 
texture, tone and lighting. 

 

1. From the Tool window, choose the Spot 
Healing Brush Tool.  

2. From the option bar, click the Brush icon to 
open the Spot Healing Brush dialog box. 
 

 
 

3. Mode:  
Normal = 
Replace = allows grain, noise and texture of original 
Type: optional 
Proximity Match = uses pixels outside  the brush to make repairs. 
Content-Aware = replaces and removes using outside content aware 
Create Texture = adds noise and texture 
Size = adjusts the brush size 
Hardness = adjusts the brush edge softness 
Spacing = adjust the brush’s proximity to other detail in the image 
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Use the Clone Stamp Tool  

The Clone Stamp tool  paints one part of an image over another part of the same 
image or over another part of any open document that has the same color mode. You 
can also paint part of one layer over another layer. The Clone Stamp tool is useful for 
duplicating objects or removing a defect in an image. 

 

1. From the Tool window, choose the Clone 
Stamp Tool.  

2. From the option bar, click the Stamp 

icon to open the Clone Stamp dialog 
box. 
 
 

 
 

3. Mode:  
Normal = 
Replace = allows grain, noise and texture of original 
Opacity = level of opacity 
Flow = amount of flow through tool 
Aligned Sample : Current Layer 
Size = adjusts the stamp size 
Hardness = adjusts the edge softness 
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Converting an RGB Colour Scan to Black-and-White in Adobe 
Photoshop CS5 

Do one of the following techniques: 

Using the Photoshop Camera Raw Dialog:   
1. Open a file (raw, jpg, tiff) in Photoshop CS5 Camera Raw from Adobe Bridge 

by select the file then click CMD+R (MAC).  
2. In the Camera Raw dialog box, choose the HSL/Grayscale tab.  
3. Click the Convert to Grayscale tick box.   
4. Use the individual colour sliders to adjust the image.  

Note: in a standard portrait image there is an S shape curve from top to 
bottom of colour sliders. 

5. Adjust the colour sliders to suite your conversion preference. 

 

Using the Black & White Adjustment Layer in Photoshop 

1. In the Adjustments panel, Click the Black & White icon  or a Black & 
White preset in the Adjustments panel.   
Or   
Choose Layer > New Adjustment Layer > Black & White. In the New Layer 
dialog box, type a name for the adjustment layer and then click OK.  

2. Photoshop applies a default greyscale conversion.  
Note: You can also choose Image > Adjustments > Black & White. But keep 
in mind that this method makes direct adjustments to the image layer and 

discards image information.   
3. In the Adjustments panel, manually adjust the conversion using the color 

sliders, apply an Auto conversion, or select a previously saved custom mix.  
Preset menu  
Select a predefined grayscale mix or a previously saved mix. To save a mix, 

choose Save Black & White Preset from the panel menu.  
Auto Sets a grayscale mix based on the color values of the images, 
maximizing the distribution of gray values. The Auto mix often produces 
excellent results, or can be used as the starting point for tweaking gray 

values using the color sliders.  
Color Sliders  
Adjust the gray tones of specific colors in an image. Drag a slider left to 
darken or right to lighten the gray tones of an image’s original color. 

4. To adjust a particular color component, select the On-image adjustment 

tool   and then click in the image. Drag left or right to modify the color 
slider for the predominant color at that location, making it darker or brighter 
in the image. 
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Note: If you are using the Black & White dialog box instead of the 
Adjustments panel, click and hold on an image area to activate the color 
slider for the predominant color at that location, then drag horizontally to 
shift the slider. 

5. Click the Reset button  to reset all color sliders to the default grayscale 
conversion. 
 

6. Preview the final results.   
Deselect to view the image in its original color mode. 
 

7. Add a bit of tone and contrast to make it more punchy, if you want. 

 

8. Save the corrected file to 8-bit grayscale. 

 

 

 

Creating a derivative file for print or web 

After you have made adjustments and corrections to the access copy and have saved 
your file, you can downsize to produce an copies for the web or for print. 

To Save for Print 
If you are saving to print or use in a document, you may want to make the image 
smaller, to exactly the print size you need.   

From the menu, choose Image->Image Size 
The Image Size dialog box will appear. Ensure that all three boxes at the bottom are 
checked; Scale Styles, Constrain Proportions, and Resample Image. 

Change the Document Size to the appropriate size you want to print to in inches or cm 
or mm.  The Resolution should be a minimum of 72 pixels/inch, but ideally for print you 
would want to use 300 pixels/inch. 

Change the very bottom dropdown choice to: 
Bicubic Sharper (best for reductions)  if you are making the image (and file size) smaller.   

You shouldn’t be enlarging, but if you are, choose Bicubic Smoother (best for 
enlargement), if you are making the image (and file size) larger. 

Click OK 

If you are happy with the size and quality of the resulting image, choose the Save As 
option from the menu bar File ->Save As 
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From the Save As dialog, there are a number of file formats to choose from, including 
JPEG, PNG, and TIFF.  These are all acceptable for print or use in documents. 

To Save for the Web 
If you want to product an image for the web, choose  
File->Save for Web and Devices… 

The Save for Web & Device dialog box will appear.  

From here there are a number of options you can choose. You should specify the exact 
Image Size width and height in pixels, and you can preview any combination of choices. 
And you can save to a number of default web optimized preferences for GIF, JPEG and 
PNG. 

After you have entered your desired options, hit the Save button and your choice of 
web optimized image will be created. You will be asked where you want to save the 
image. 
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Creating derivatives using IrfanView 
 
IrfanView is a freeware program that you can download from http://www.irfanview.com/ 

Once you have created your master image or corrected master you can use IrfanView to create 

copies/derivatives for printing or for web viewing, etc.   You can process folders of images using the 

following sample procedures.  

Make sure you know which folder of images you want to select and create an output folder in advance 

where you want the images to end up.  

Open IrfanView 

Under the File tab, select Batch Conversion/Rename… 

 

From the left top: Select Batch conversion 

Choose Output format: JPG – JPG/JPEG Format (options button) 

 

http://www.irfanview.com/
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On the top right go to Look in: select the folder and make sure the images appear in the window 

Choose Add all: - all the image files should appear in the second window 

Choose: Start Batch  
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Exit batch or run again on a new folder.  

If you want to change any parameters of the file such as the resolution (DPI)  

Select the Advanced button after choosing the Output format. In the example below the DPI value was 

changed to 72.  Resizing images to a standard size for example by a % or a number of pixels e.g. 500 on 

the long side to fit a particular layout.   
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